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Chapter 1
Introduction
Peregrine Systems’ Get.It! product suite is a line of employee self-service applications. 
The Get.It! applications empower employees to help themselves to functions once requir-
ing numerous e-mails, phone calls, inter-office correspondence, and paperwork to com-
plete. For example, the Get.Resources! application streamlines the MRO procurement 
cycle by drastically reducing cost and time while simultaneously increasing employee 
productivity and satisfaction.

Get.It! applications are accessible on the corporate intranet via web browsers. The user 
interface, a best of the web experience, is role-based and you can tailor it to meet your 
needs.

Get.It! applications benefit organizations both by freeing employees from time-consuming 
tasks and by automating inefficient processes such as procurement, service, and searching 
for answers to common questions.

About this Manual
• The Get.It! Administration Guide describes the administrative steps for Peregrine 

Systems’ Get.It!. After the installation and configuration is complete, use this manual 
to monitor the server connections, perform user administration, change control 
settings, and set up NT Challenge and Response.

The Get.It! Administration Guide is used with several other manuals, which are:

• Operating guides, reference manuals, and other documentation for your PC hardware 
and operating software.

• The Get.It! Installation Guide which describes how to install and configure Get.It! on 
both a Windows and Solaris server.

• The Get.It! Tailoring Guide which describes how to customize Get.It! to suit your 
needs. It also describes the basic architecture on top of which Get.It! is programmed.

• Get.It! Online Help, a good source for weblication tags and internationalization. 
Located in the ...\getit\docs\help\getit\windows directory.

• JRun documentation located online in the ...JRun\docs directory

To use this manual effectively, you should have a working knowledge of both the PC 
hardware and operating software, and of the database management for the back-end sys-
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tems you are linking to Get.It! (such as ServiceCenter and AssetCenter). 

Organization of the Manual

This manual is organized around the main functions associated with the administration of 
Get.It!. The following chart shows you which parts of the manual you need to reference to 
find the information you need. 

To Find This Look Here

Background information; how to use this manual. Chapter 1: Introduction

Resetting the server link to the back-end systems; 
monitoring the server log; setting controls in the 
archway.ini file.

Chapter 2: Get.It! Administration 
Module

Information regarding user IDs; registering users; 
authorization to ServiceCenter and AssetCenter; 
access to Get.It! modules.

Chapter 3: User Administration

Information regarding Get.Answers!; the differences 
between document collections and knowledgebases; 
creating a site.

Chapter 4: Get.Answers!

Setting up NT Challenge and Response; setting 
permissions for file access; testing the setup of NT 
Challenge and Response.

Chapter 5: NT Challenge and 
Response

Using AssetCenter product catalogs; how Get.It! 
distinguishes between different types of goods; 
calculated fields.

Chapter 6: Catalog Information

Using the File Attachment utility to attach files to new 
or existing problem tickets.

Chapter 7: File Attachments

Verifying the connections to AssetCenter and 
ServiceCenter. Troubleshooting the JRun 
configuration. Ensuring the IIS configuration is set 
correctly.

Chapter 8: Troubleshooting
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Conventions Used in this Manual

Most screen shots in this manual come from the Windows version of Get.It!. The action 
you should take on the window is usually explained in the step below the sample. If infor-
mation is printed next to the window, it is important and you should pay special attention 
to it. For example:

Buttons, Directories, and File Names

The following conventions are used when describing buttons on the windows, paths for 
directories, and file names.

• Buttons you click are shown in bold such as “Click Next.” 

• Directory paths are shown in Courier New font, such as C:\Program
Files\getit\. The directories used in this manual are the default directories 
assigned during the installation. If you change the directory into which you install 
Get.It! or JRun, make sure you make note of the correct directory and replace the 
default path with the one that is correct for your system. 

• File names are also shown in Courier New font, such as login.asp.

• All screen shots are in the Classic Get.It! scheme. Your screens may be different 
depending upon the Skin and/or Stylesheet you have selected.

Do not install JRun 
if you already have 
the current version 
installed on the 
server. 
Do not install a 
newer version of 
JRun on top of an 
older version. 
Uninstall the older 
version first.

Fig. 1.1 Choosing whether to install JRun.
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Chapter 2
Get.It! Administration Module
Get.It! provides you with an Administration module which you can use to monitor how 
Get.It! is working and to change the control options in the Archway.ini file. This makes it 
easy for you to determine issues with the connections between ServiceCenter, AssetCenter 
and any other system to which you have Get.It! connected. 
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Using the Administration Module
The Get.It! Administration module allows you to:

• Monitor the connection between the Get.It! server and the ServiceCenter and 
AssetCenter servers

• View the server log, which shows all activity on the Get.It! server

• View and change the settings in the Archway.ini file

• Show Script Status is for starting and stopping various JScript functions

• Show Message Queuing to view queue contents

• Queue Status to view all queues

1. To begin using the Get.It! Administration module verify both the IIS or PWS and 
JRun servers are started.

2. Verify that your ServiceCenter server is running, if you have implemented 
Get.Service!.

3. Open a browser window.

4. Log in to Get.It! using a user ID with AssetCenter profile of getit.admin. Click on the 
Admin module button. Or, you can enter the following URL: http://webserver/
getit/admin.jsp in the browser address field (replace webserver with the name of 
your web server and getit with the virtual directory name). 

5. Press ENTER. 

The first time you access the Administration module through the admin.jsp, you are 
asked to setup the administrator’s ID and password. Enter the information and click 
Logon as Administrator. If you have not yet entered an Administrator’s ID and pass-
word, you can just click Logon as Administrator without entering any information. 

If you enter using the Admin button after logging in to Get.It! then you are linked directly 
to the CNTRL panel.
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Using the Control Panel

When you first log in, the Control Panel window is displayed. 

Use this window to check the status of the connections to ServiceCenter and AssetCenter 
as well as any other adapters youhave configured. You can also reset the server, if neces-
sary, by pressing Reset Server. 

There are two activities available from this window. Click Server Log to view activity on 
the Get.It! server. Click Settings to view and change the settings in the Archway.ini file. 
If AssetCenter is loaded on a server different from Get.It!, update the Archway.ini file 
to reflect the appropriate connection name and the Administrator’s user name and pass-
word. 

Viewing the Server Log

The Server Log provides the history of the server. You can choose the number of lines to 
make available when scrolling down the screen. Click Reset to clear the log of Refresh to 
update.

Fig. 2.1 Administration Module Control Panel
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Archway.ini Settings

Click Settings to display the current settings in the Archway.ini file. This file allows you 
to control items such as:

• General Execution Options (debug logging and scripting, session time-out, and 
adapters, language and currency settings)

• Weblication Settings

• AssetCenter Adapter Settings

• ServiceCenter Adapter Settings

• Email Settings

• B2B Settings

• Advanced Settings (tracking options and event queue)

Each available option is explained on the screen. See figure 2.3, below.

Fig. 2.2 Administration Module Server Log
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Archway will not record all activity unless LogStdout is set to true within the arch-
way.ini file. The default for this setting is false. Change this setting to true to begin log-
ging activity. If the log exceeds 1,000,000 characters then the Log class will save a copy 
within the “log_file”.backup (the name of the log file plus *.backup extension) and 
overwrite previous backups. The 1,000,000 character maximum can be modified either 
from the Archway.ini file or through logging in as an Admin and then setting Max-
LogSize. 

Archway.ini Parameters
The following table lists the archway.ini parameters and gives a description of each. 
The default entries are shown after the equal sign  (=) for each parameter. 

Fig. 2.3 Administration Module Settings
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Parameter Description

debugforceddeclarations=false Select this to generate log information useful when 
troubleshooting the server. 

defaultcapabilities=sc(getit.servi
ce);portalDB(getit.portal);getans
wers(getit.answers;getit.answers
.advanced)

Semicolon separated list of access rights that all users should 
have regardless of their profile. Access rights are assigned to 
Target adapters in the following way:

   sc(getit.service;getit.answers);portalDB(getit.portal)

scriptpollers=false Select to enable script processing. Normally, this should be 
set to true. A setting of false will stop your server from 
performing background tasks. 

b2bupdatesserver=b2bserver.get
marketaccess.com

Enter the URL for the Peregrine B2B Server used by this 
site. 

images=images/ Set the Skins directory location. The directory name must be 
specified relative to the 'presentation' directory. Setting this 
allows you to move the default location of the skins 
directory to another location. 

The default is "images/skins"

adapters=sc=SCAdapter;ac=AC
Adapter;portalDB=ACAdapter;
getanswers=SCAdapter

Semicolon separated list of Target and Adapter assignments 
supported by Archway. For instance:

  sc=SCAdapter;ac=ACAdapter

cookieexpiration=2592000 Number of seconds to store Weblication user settings as 
browser cookies. For instance, a user's name and password is 
remembered by a weblication by storing it in a cookie. 

acadminpassword= Administration password used by Get.It! when performing 
tasks such as user authentication and registration 
AssetCenter.

mailpassword= User password used to access the mail server. 

mailuser= User name used to access the mail server. 

getanswers.backend=irexpert Set to IREXPERT for ServicCenter; set to KNOWLIX for 
Get.Answers! server.

schost=localhost Host name of ServiceCenter server. 

getitclientname= Enter the name of your company. 

getitclientidtype=DUNS Your company's ID# type should be DUNS. 
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logfile=d:\program 
files\getit\archway.log

Enter a full directory path to the file used for logging. 

mailsender= Reply address used when sending email. 

getitclientid= Your company’s DUNS number.

maxscriptrunners=10 Maximum number of script execution threads. The default is 
10. 

adminname= Administration user used to log in to the Admin.jsp page.

getitclientlocation= Get.It! client location.

resolveappstrings=true Set to true if you want to resolve any application strings.

logo=images/logos/
logo_getit_green.gif

Set the logo to be used in the application. The path must be 
relative to the presentattion directory. 

The default is "images/logos/logo_getit_green.gif". 

sclog=d:\program 
files\getit\sc.log

Path to SC logging used by the ServiceCenter client 
connection 

ns_css=ns_css/ Directory path for CSS stylesheets directory for Netscape 
Navigator browsers.

scadmin=falcon Administration user used by Get.It! when performing tasks 
such as user authentication and registration in ServiceCenter.

mailhost= Mail server host used by Get.It! to send email messages 

skins=skins/ Set the Skins directory location. The directory name must be 
specified relative to the ...\presentation\images\ 
directory. Setting this allows you to move the default 
location onf the skins directory to another location. The 
default is ...\skins. 

debuglog=true Select this to generate log information useful when 
troubleshooting the server 

currency=USD Comma separated list of ISO-4217 currency codes that 
define which currencies will be used in a given installation. 
The first code defines the default currency to use when a 
currency type is not specified. For example, USD,EUR 
defines US Dollars and European Euros as supported 
currencies. 

acanonymouspassword= Anonymous user password for AssetCenter.

b2badminmailto=b2badmin@ge
tmarketaccess.com

Enter the e-mail address for the Peregrine B2B Server used 
by this site. 

Parameter Description
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scanonymouspassword= Anonymous user password 

weblication=getit.xml The default weblication file.

getanswers.grp.default=http://
machinename/getanswers

Default initial logon, before assigned a site for Get.Answers! 
server.

scripttimeout= Number of milliseconds to allow an inactive session to exist 
before autologout 

stylesheet=classic.css Set the CSS Stylesheet name for user sessions. The default is 
"classic.css". 

logstdout=false Normally set to false. Enables logging to ...\jrun\jsm-
default\logs\stdout.log.

displayforminfo=false When selected, form information is displayed in each screen 
to aid during weblication development and customization. 

maildomains=peregrine.com;aps
ydev.com;getmarketaccess.com

Enter a semicolon separated list of mail domains that Get.It! 
may correspond with. Only users with an email address in 
these domains are allowed to complete online self-
registration. 

QManStorageAdapter=ac AssetCenter B2B adapter.

acdatabase=ACDemo300ENG Name of AssetCenter database 

derivedscriptpath= Source script directory.

acanonymous=Admin Anonymous user name for AssetCenter. 

scanonymous=falcon Anonymous user name used when an unknown user attempts 
to communicate with ServiceCenter 

acdateformat=yyyy-MM-dd AssetCenter date format.

adminpassword= Administration password for Admin.jsp page.

debugscript=true Select to ease the development and troubleshooting of 
scripts. When enabled, scripts and schemas are reparsed 
each time they are invoked. Be sure to turn this off in a 
production system. 

problemdefaultcategory=
example

The default problem category for Get.Service! tickets.

maxlogsize=1000000 Enter maximum size for the log file in bytes. 

sessiontimeout=6000000 Number of milliseconds to allow an inactive session to exist 
before autologout.

Parameter Description
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statestorage=StateMemory Memory, fastest choice but depends on continuous service 
from one Web Server. 

sclog The location of the sclog file. The default is 
C:\Program Files\getit\sc.log.

scport=12670 Port number of ServiceCenter server.

locale=en Comma separated list of supported locales that define the 
languages available and locale specific variations based on a 
user's country. A user's browser can be configured to display 
a specific language and format dates and currency based on a 
certain country's conventions. The first locale defines the 
default used. A locale is specified by combining the ISO-639 
language code and optionally with the ISO-3166 Country 
code separated with an underline. For example, "en" or "fr" 
can be specified for English or French support, whereas 
"en_US" and "en_GB" can further refine the locale so that 
dates are formatted Mon/Day/Year in the United States and 
Day/Mon/Year in Great Britain. The value en,fr,de,it 
specifies that English, French, German, and Italian are all 
supported in a given installation. 

defaultskin=classic The default skin that is used when a user first logs into 
Get.It! If you change the default to another style then this 
style will be recorded in a database as well as in the 
browser's cookie.

defaultstylesheet=classic The default stylesheet that is used when a user first logs into 
Get.It! If you change the default to another style then this 
style will be recorded in a database as well as in the 
browser's cookie.

scadminpassword= Anonymous user password for ServiceCenter.

ie_css=css/ Directory path for CSS stylesheet direcotry for Inernet 
Explorer.

acadmin=Admin Administration user name for AssetCenter.

acapidll Used with AssetCenter version 3.5 and above. This 
parameter is not mandatory because Get.It! can detect and 
load the correct DLL based on the connection name defined 
the the acdatabase parameter. When this parameter is not 
specified Get.It! uses the information provided by 
AssetCenter in the connection description (amdb.ini) to 
determine the DLL name. Use this parameter only if the 
default name determination does not work.

Parameter Description
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acapidllpath Gives the path to the folder in which the AssetCenter API 
DLL is located. If this paramter remains blank, Get.It! 
searches those folders in which AssetCenter is installed for a 
DLL with the expected name. If the requested DLL is not 
located then Get.It! will load it from its bin folder. This 
parameter should be used only if the default path 
determination does not work as expected. Note that in the 
case where the locale parameter in archway.ini contains “ja” 
(meaning that you intend to use Japanese), Get.It! will only 
load the API DLL from an AssetCenter Japanese folder, and 
if it does not find it there it will load it from ...\bin\ja\.

acdefaultloginclass Establishes the type of default user login.This parameter can 
have four different values. If it is empty or not specified in 
archway.ini then self-registered users are added to 
AssetCenter with the default login class defined in 
AssetCenter. Out of the box, the default for a registered user 
in AssetCenter is named user. If the value is casual, 
(acdefaultloginclass=casual) the self-registered 
user will be added as a floating user. If the value is 
floating, (acdefaultloginclass=floating) the 
self-registered user will be added as a floating user. If the 
value is named, (acdefaultloginclass=named) the 
self-registered user will be added as a named user. Casual, 
floating, and named user are each described in the 
AssetCenter documentation.

b2bserverhost=https://
www.getmarketaccess.net

Enter the URL for the Peregrine B2B Server used by this 
site. 

JRunRoot=d:\Jrun\ The root JRun directory; default for installation.

AppsPath=apps/ The root directory for the Get.It! application.

request.backend=sc The back-end system to use for Resources, Status, and 
Approvals options. Enter “sc” for ServiceCenter, or “ac” for 
AssetCenter.

purchaseorder.backend=sc The back-end system to use for receiving. Enter “sc” for 
ServiceCenter, or “ac” for AssetCenter.

ACConncectionPool=false Default value is true. This adapter consists of a database 
connection pool that allows the ACAdapter to combine users 
of the same profile into using the same connection. This 
quickens the process because the AmSUImpersonate call 
does not proceed with the login procedure when a user’s 
profile is the same as the last impersonated user. 

Parameter Description
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ISO Chart for Locale and Currency

The following chart shows the ISO codes to use in the “Locale” and “Currencies” fields in 
the Settings. All languages and currencies are not currently available. Check your latest 
Release Notes for the supported languages. 

Language Language 
Code Country Country 

Code Currency Currency 
Code

Albanian sq Albania AL Lek  ALL

Arabic ar United Arab 
Emirates

AE Dirham  AED

ar Bahrain BH Dinar  BHD

Arabic ar Algeria DZ Algerian 
Dinar

 DZD

ar Egypt EG Pound  EGP

ar Jordan JO Dinar  JOD

ar Kuwait KW Dinar  KWD

ar Lebanon LB Pound  LBP

ar Libya LY Dinar  LYD

ar Morocco MA Dirham  MAD

ar Oman OM Sul Rial  OMR

ar Qatar QA Rial  QAR

ar Saudi 
Arabia

SA Riyal  SAR

ar Sudan SD Dinar  SDD

ar Syria SY Pound  SYP

ar Tunisia TN Dinar  TND

ar Yemen YE Rial  YER

Bulgarian bg Bulgaria BG Lev  BGL

Byelorussian be Belarus BY Ruble  BYR

Catalan ca Spain ES Peseta  ESP
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Chinese zh China CN Yuan 
Renminbi

 CNY

zh Hong Kong HK Dollar  HKD

zh Taiwan TW Dollar  TWD

Croatian hr Croatia 
(Hrvatska)

HR Kuna  HRK

Czech cs Czech 
Republic

CZ Koruna  CSK

Danish da Denmark DK Krone  DKK

Dutch nl Belgium BE Franc  BEF

nl Belgium BE Euro  EUR

nl Netherlands NL Euro  EUR

Dutch nl Netherlands NL Guilder  NLG

English en Australia AU Australian 
Dollar

 AUD

en Canada CA Dollar  CAD

en Ireland IE Euro  EUR

en Great 
Britain (UK)

GB Pound 
Sterling

 GBP

en Ireland IE Punt  IEP

en New 
Zealand 
(Aotearoa)

NZ Dollar  NZD

en United 
States

US US Dollar  USD

en South Africa ZA Rand  ZAR

Estonian et Estonia EE Kroon  EEK

Finnish fi Finland FI Euro  EUR

fi Finland FI Markka  FIM

Language Language 
Code Country Country 

Code Currency Currency 
Code
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French fr Belgium BE Franc  BEF

fr Canada CA Dollar  CAD

fr Switzerland CH Franc  CHF

fr Belgium BE Euro  EUR

fr France FR Euro  EUR

fr Luxembourg LU Euro  EUR

fr France FR Franc  FRF

fr Luxembourg LU Franc  LUF

German de Austria AT Schilling  ATS

de Switzerland CH Franc  CHF

de Germany DE Deutsche 
Mark

 DEM

de Austria AT Euro  EUR

de Germany DE Euro  EUR

German de Luxembourg LU Euro  EUR

de Luxembourg LU Franc  LUF

Greek el Greece GR Drachma  GRD

Hebrew iw Israel IL Shekel  ILS

Hungarian hu Hungary HU Forint  HUF

Icelandic is Iceland IS Krona  ISK

Italian it Switzerland CH Franc  CHF

it Italy IT Euro  EUR

it Italy IT Lira  ITL

Japanese ja Japan JP Yen  JPY

Korean ko Korea 
(South)

KR Won  KRW

Latvian lv Latvia LV Lat  LVL

Lithuanian lt Lithuania LT Lita  LTL

Language Language 
Code Country Country 

Code Currency Currency 
Code
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Macedonian mk Macedonia MK Denar  MKD

Norwegian no Norway NO Krone  NOK

Polish pl Poland PL Zloty  PLZ

Portuguese pt Brazil BR Brazilian 
Real

 BRR

pt Portugal PT Euro  EUR

pt Portugal PT Escudo  PTE

Romanian ro Romania RO Leu  ROL

Russian ru Russian 
Federation

RU Ruble  RUR

Serbian sr Yugoslavia YU New Dinar  YUN

Serbo-
Croatian

sh Yugoslavia YU New Dinar  YUN

Slovak sk Slovak 
Republic

SK Koruna  SKK

Slovenian sl Slovenia SI Tolar  SIT

Spanish es Argentina AR Peso  ARP

Language Language 
Code Country Country 

Code Currency Currency 
Code
2-14 Archway.ini Parameters



Spanish es Bolivia BO Boliviano  BOB

es Chile CL Peso  CLP

es Colombia CO Peso  COP

es Costa Rica CR Colon  CRC

es Dominican 
Republic

DO Peso  DOP

es Ecuador EC Sucre  ECS

es Spain ES Peseta  ESP

es Spain ES Euro  EUR

es Guatemala GT Quetzal  GTQ

es Honduras HN Lempira  HNL

es Mexico MX Peso  MXP

es Nicaragua NI Cordoba Oro  NIO

es Panama PA Balboa  PAB

es Peru PE Nuevo Sol  PEN

es Paraguay PY Guarani  PYG

es El Salvador SV Colon  SVC

es Puerto Rico PR US Dollar  USD

es Uruguay UY Peso  UYU

es Venezuela VE Bolivar  VEB

Swedish sv Sweden SE Krona  SEK

Thai th Thailand TH Baht  THB

Turkish tr Turkey TR Lira  TRL

Ukrainian uk Ukraine UA Hryvnia  UAH

Language Language 
Code Country Country 

Code Currency Currency 
Code
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Ge
Chapter 3
User Administration
With Get.It!, user administration is almost completely automated. Users can register them-
selves and log in using any name currently registered in either AssetCenter or Service-
Center. 
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User Registration
The Get.It! weblication has been designed so that users can register on-line, eliminating 
the need for a system administrator to respond to every request for access. 

The basic information and login scripts are stored in the .../getit/apps/com-
mon/jscript/ directory. Basic registration and login scripts are in the file named 
login.js. If you want to make changes to the registration process, such as changing the 
way a user’s password is defined, you can change the scripts in this directory.

The users will be prompted for certain default information, as identified on the registration 
screen below.

Once this information has been provided, Get.It! will transform this data in to a Profile 
record that will then be passed to the ServiceCenter and AssetCenter systems. An operator 
record will be created in ServiceCenter with data matching that passed in, plus default 
Capability Words of getit.service and getit.answers. In AssetCenter, an amEmplDept 
record is created with the user-supplied and a default Profile will be assigned, 
getit.default. A contact record is also created for the new user in ServiceCenter.

Fig. 3.1 Registering a new user

The adapter must be 
defined before the 
capability words will 
be recognized. For 
example, if no 
adapter is defined 
for Service Center, 
the ServiceCenter 
capability words will 
not be used.
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User Authentication
When a user attempts to log on to the weblication, the user name and password they enter 
are validated against the AssetCenter and ServiceCenter profiles. The name and password 
combination may be valid in none, one, or both of the systems. If the entered combination 
is invalid or does not exist in any systems, the user will be prompted to enter a valid user 
name and password. If correct in both systems, the weblication will retrieve the access 
rights for the user and log them in to Get.It!. If the combination is valid in one but not both 
systems, the access rights defined in the profile where the user name and the user pass-
word are valid.

You can also remove password authentication. The JavaScript that authenticates user 
login is located in the ...\apps\common\jscript\login.js file. Located within this 
file you will find the login() function. Overriding this function will remove password 
authentication. 

Access Rights

Access rights within Get.It! are addressed in a manner similar to traditional ServiceCenter 
and AssetCenter access. 

In ServiceCenter, capability words are associated with each operator record to identify 
what system options they have access to. Get.It! uses new capability words to restrict 
access to the Service and Answers modules within the weblication.

Capability Word Module you can Access:

 getit.service Service

getit.answers Answers
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AssetCenter utilizes user rights to identify which tables an operator may modify within the 
system. Profiles group user rights together. Individual Employee records can have a single 
Profile associated to them. Get.It! examines the name of the user right that an individual 
has, and uses it to provide access to various portions of the weblication. AssetCenter con-
tinues to restrict table access based on the detail of any given user rights record. 

Named user rights have been established for use with the Get.It! weblication:

User Right Module you can Access:

getit.admin Administration

getit.approver Approvals

getit.asset Assets

getit.receiver Receiving

getit.requester Resources

getit.advancedrequester Resources with the ability to modify line 
items

getit.assetrun IMAC

Fig. 3.2 ServiceCenter Capabilities & Get.It! menu options
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Profiles have also been established for use within the weblication: 

The profile getit.default is assigned to all new users that register through the weblication. 
The getit.full profile is not given automatically by the weblication, but rather should be 
given by an AssetCenter user administrator. 

getit.b2badmin B2B Administration

getit.shopdirect Resources with ShopDirect

getit.shopdirect.[supplies] Resources with ShopDirect permission 
for a specific supplier

Profile Module you can Access:

getit.admin Administration, B2B Administration, 
Resources, Status, Approval, Receiving, 
IMAC, Shop Direct, 

getit.default Resources, Status

getit.full Resources, Status, Approval, Receiving, 
IMAC, B2B Administration, ShopDirect

User Right Module you can Access:
User Administration 3-5



Note: “getit.default” includes Resources and Status. “getit.full” includes default options 
and Approval and Receiving. “getit.admin” includes full options.

When users first register, they are assigned getit.default authority. You need to update the 
Employee records of those users who you want to have full and administration access.

Fig. 3.3   AssetCenter profile to Get.It! menu options
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Setting the User’s Language
When a user logs into Get.It!, the login programs detect the preferred language set in the 
browser and determine if the user’s language is supported by Get.It! If the language is sup-
ported Get.It! will be displayed in that language.

If the language is not supported, the default language is used. The default language is set 
in the Archway.ini file through the Locale field in the Administration Module. The first 
entry in this field is the default language.

If you chose to install multiple languages (during the Get.It! Installation Procedure), the 
Get.It! Login window includes a select box with a list of the installed languages. When the 
user selects a language, the Login window is redisplayed with the chosen language as 
shown below. 

Note: When you first login, if your default language is English the Welcome screen is 
displayed in English. If you select to use Get.It! in French, the window is 
immediately translated into French.

All window content will be displayed in the language chosen by the user. The only excep-
tion is if the back-end system data will be shown in the language supplied by that system. 
If the back-end system is loaded in German, the data from that system will display in 
Get.It! as German. 

All dates and currency are displayed and edited in the user’s language. The formatting is 
done when the weblication <field> or <input> tags have a type attribute equal to “date” 
or “currency.” Calendars display the translated weekday name and start the week on the 
user locale’s first day of the week. 

Fig. 3.4 Language selection
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Currency is displayed using the correct symbol and decimal indicator, however, the deci-
mal point and the thousands separator are determined by the user’s preferred language and 
not the currency being displayed. For example, a French-speaking user will see US dollars 
as $1 234,00, a German-speaking user will see $1.234,00, and an English-speaking user 
will see $1,234.00.

If you have tailored Get.It! and want the tailored portions to display in languages you will 
need to follow the instructions in the “Localization Support” chapter of the Get.It! Tailor-
ing Guide. 
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Chapter 4
Get.Answers!
Using Get.Answers!, you can search knowledgebases created in KnowlixAuthor and 
document collections created in KBMake. Document collections contain source 
documents in their native format. The following formats are supported for document 
collections:

• Adobe Acrobat (PDF)

• HTML

• Microsoft Word, Excel, and PowerPoint

• XML

Knowledgebases and document collections have the same file extension (.nfo) so the 
Get.Answers! server can treat the files the same when viewing in Get.It!. However, 
knowledgebases and document collections are not compatible. The content is created and 
managed differently for each type. It is important you don’t interchange the two types of 
.nfo files. 

You create the two types of .nfo files differently. Use KnowlixAuthor to create 
knowledgebases. Then do the following:

• Create a site for the knowledgebase

• Add the knowledgebase to SiteAdmin

Creating document collections is a more complex process. To create a document 
collection, do the following:

• Create a directory structure for the documents in Windows Explorer

• Create a document collection using KBMake

• Create a site for the document collection

• Add the document collection to SiteAdmin
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Knowledgebase Overview
Use KnowlixAuthor as you normally would to create unofficial knowledge entries and to  
perform the process of making the knowledge entries official, secure knowledgebases. For 
more information on creating knowledgebases, refer to your KnowlixAuthor 
documentation.

To view a KnowlixAuthor knowledgebase in Get.Answers!, do the following:

1. Create a site for the knowledgebase. To do this, see “Creating a Site Definition File” 
on page 4-5. 

2. Add the knowledgebase to SiteAdmin. To do this, see “Adding a Knowledgebase or 
Document Collection to SiteAdmin” on page 4-14. 
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Document Collection Overview
Use KBMake to create a document collection of native documents that you want to add to 
a site. When you create a document collection, KBMake recreates the .nfo file each time. 

To create a document collection, do the following:

1. Create a site for the document collection. To do this, see “Creating a Site Definition 
File” on page 4-5.

2. Create the directory structure to assign document collections to different groups. To 
do this, see “Setting Up a Directory Structure” on page 4-11.

3. Create a document collection using KBMake. To do this, see “Creating a Document 
Collection” on page 4-12.

4. Add the document collection to SiteAdmin. To do this, see “Adding a Knowledgebase 
or Document Collection to SiteAdmin” on page 4-14.
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Site Overview
A site consists of document collections and knowledgebases hosted by a Get.Answers! 
server. The definition of a Get.Answers! site is stored in an xml file (known as the site 
definition file). Create as many sites as you need to share a common set of documents 
between sites or to restrict access to sites by requiring authentication. 

Note: Users have access to all knowledgebases and document collections within the site 
they are assigned.

To create a site, do the following:

1. Create an .sdf file for the site. To do this, see “Creating a Site Definition File” on page 
4-5.

2. Register the site with the lpApp.ini file. To do this, see “Registering a Site” on page 4-
7.

3. Create a virtual directory using Internet Information Server (IIS). To do this, see 
“Creating a Virtual Directory” on page 4-8.

To have Get.Answers! recognize the new site, you need to map it in the archway.ini file. 
To do this:

1. Define the sites in the archway.ini file. To do this, see “Defining a Site” on page 4-9.

2. Update the user profile in AssetCenter or ServiceCenter. To do this, see “Updating a 
User Profile” on page 4-9. 

Note: You will also need to refresh the Get.Answers! server any time you add a new site. 
To do this, see “Setting Up a Directory Structure” on page 4-11.
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Creating a Site Definition File
A site definition file is an XML document that defines the sites hosted by a Get.Answers! 
Web server. A site definition file specifies the documents and other files available at the 
site. It also specifies the hierarchical organization of the files.

The Document Type Definition (DTD) file defines the format a site definition file must 
follow. The default site definition file is called SiteDefinitionFile.dtd.

Note: To modify the site definition file, see Chapter 5: Tailoring Get.Answers! in the 
Tailoring Guide.

To create a site definition file:

• Make a copy of Template.sdf in the bin directory and rename it with the desired site 
name. For example, you might have Human Resources.sdf as a site name. In the new 
.sdf file you created, you need to change the following attributes in the site definition 
file: id, name, and the title. See the following example on how to do this:

<?xml version="1.0"?>

<!DOCTYPE site SYSTEM "file:SiteDefinitionFile.dtd">

<site

content-type="text/html"

document="main-h.htm"

hidden="no"

highlight-style="font-weight: bold; color: #ffcc00;"

id="1.3/GetAnswers"

images="C:\Program Files\GetAnswers\templates"

name="GetAnswers"

objects="C:\Program Files\GetAnswers\objects"

online="yes"

query-timeout="30000"

session-timeout="900000"

stylesheets="C:\Program Files\GetAnswers\templates"

templates="C:\Program Files\GetAnswers\templates"

title="Get.Answers!"

version="2.0"

<folder

id="Getanswers"

Change the id, 
name, and title 
attributes to reflect 
the name of your 
new .sdf file.
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name="Getanswers"

title="Getanswers"

• When you add a knowledgebase or document collection to SiteAdmin, it will ask you 
what site definition file you want to use. This determines what site the knowledgebase 
or document collection is added to.To add a knowledgebase or document collection to 
SiteAdmin, see “Adding a Knowledgebase or Document Collection to SiteAdmin” on 
page 4-14.

Updating the Site Definition File with the Command Line Utility
To update changes you make to the site definition file, use the Command Line 
Configuration Utility. To do this, perform the following steps:

1. Select Run from the Start menu.

2. Enter the following command in the Open field:                                                                 

           SiteAdmin “C:\Path\SiteDefFile.sdf” “C:\Path\Knowledgebase.nfo”

Note: If the path name contains spaces or periods, enclose the path in quotes (“) in order 
for the command to work properly.
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Registering a Site
All new sites must be registered in a file called lpApp.ini located in the same directory as 
lpApp.dll. Each site has its own section in the lpApp.ini.To register a site with the 
Get.Answers! server, use a text editor to add a site’s section to the lpApp.ini file located in 
the \GetAnswers\bin directory.

Note: The lpApp.ini file is set to “read” mode when lpExt.dll is loaded. Any changes 
made to the lpApp.ini file are not reflected until the lpExt.dll is unloaded and 
reloaded. To unload and reload lpExt.dll, stop the World Wide Web Publishing 
Service and start it again. Do this each time a change is made to lpApp.ini.

The following example illustrates the definition of each parameter in the lpApp.ini file:
[<AliasName>/ExtensionDll>]

SiteDefinitionFile=<SiteDefFile>

DefaultView=<DefaultViewID>

The definition for each parameter is defined below:

<AliasName>
Name of the Web server alias from where the site is accessible. The default Web server 
alias set up by the install is “getanswers.”

<ExtensionDll>
File name of the Web server extension DLL. The default file name is lpExt.dll.

<SiteDefFile>
Full path (or relative path if no path is specified) to the xml site definition file. The default 
site definition file is called getanswers.sdf and is located in the \GetAnswers\bin directory.

<DefaultViewID>
ID of the default view to use if no ID is specified in a URL to access the site. This needs to 
correspond to the value of the ID attribute of a view defined in the site definition file.

You need to change the parameters in the lpApp.ini file to refelect your new site. The 
default parameters look like the following:
[Getanswers/lpExt.dll>]

SiteDefinitionFile=Getanswers.sdf

DefaultView=1.3/Default

Change the entries 
shown in bold to the 
appropriate alias and  
site definition file 
names. 
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Creating a Virtual Directory
To create a virtual directory for a site, do the following:

1. Open Internet Service Manager.

2. Expand Internet Information Server and right-click Default Web Site.

3. Select New and then Virtual Directory.

4. In the wizard, determine the following:

• Enter an Alias Name to access the virtual directory. The Alias Name must match the 
site name indicated in the .sdf file for that site.

• Browse for the Physical Path for the virtual directory. Use the following directory: 
\Program Files\GetAnswers\Ext directory.

• Set the permissions for the virtual directory.

5. Click Finish to add the new directory.
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Defining a Site
In the Administration module of Get.It!, click Settings to define a site. When a user self-
registers, they are assigned to the default site:

getanswers.grp.default=http://machinename/getanswers 

With default capability support, you can give access to Get.Answers! to any user without 
the need for authentication. The default site is a good place to store public information that 
can be viewed by everyone.

You can separate knowledge access into groups by creating different URL addresses 
associated with each group. Get.It! uses the addresses to interact with Get.Answers!. 

Two steps are required to integrate Get.Answers! with the groups you create:

1. Define the desired site URLs in the Archway.ini file (located in the /getit/bin 
directory). Consider the following examples and replace the text in bold with the 
desired information:

                 getanswers.grp.executive=http://lpserver/executive

                 getanswers.grp.manager=http://lpserver/manager

                 getanswers.grp.humanresources=http://lpserver/humanresources

                 getanswers.grp.admin=http://lpserver/admin

Note: A user may only belong to one group.

2. Ensure each user’s profile has the proper “getanswers.grp” capability word in their 
profile. For example, if a user is in the Executive category, their SC or AC user profile 
must include “getanswers.grp.executive.” To update user profiles, see “Updating a 
User Profile” on page 4-9.

Note: You need to stop and restart JRun to update the changes you made to the 
archway.ini file.

Updating a User Profile

Authentication rights require that a user be authenticated in AssetCenter or ServiceCenter 
and that the proper capability words or user rights are added to the user’s profile. The site 
name in the profile determines the information the user will have access to. Users will 
have access to all knowledgebases and document collections within their assigned site.

The following example shows you how to update a user profile if you are using 
ServiceCenter for authentication. See the instructions below for information on updating a 
user profile if you are using Asset Center for authentication.

1. Click the Utilities tab after logging on to ServiceCenter. 

2. Click the Administration button.
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3. Click Capability Words.

4. Add the server and site name as a capability word. (e.g. getanswers.grp.manager).

5. Click the Add button. Then click the Back button twice.

6. Click Operators under Security. 

7. Enter your Login Name.

8. Click the Startup tab.

9. Under Execute Capabilities, enter the server and site name for the user. (e.g. 
getanswers.grp.manager).

10. Save the changes you made.

If you are using AssetCenter for authentication, use the following steps to update a user’s 
profile: 

1. Select Administration from the Tools menu in AssetCenter. Then select User 
Rights.

2. Click the New button.

3. Under Description, enter the site name for the user. For example, you might have 
getanswers.grp.manager as a site name.

4. Make sure all of the settings in Fields, Links, and Features and Records in Table are 
checked.

5. Select Administration from the Tools menu. Then select User Profiles.

6. Select the desired profile for the user.

7. Click the green plus sign in the User Rights tab and double-click the site name (i.e. 
getanswers.grp.manager) to add it to the profile.

Fig. 4.1 User profile descriptions in AssetCenter

Determine whether 
the user should 
have getit.default, 
getit.full, or 
getit.admin rights.

Fig. 4.1 User profile descriptions in AssetCenter
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Setting Up a Directory Structure
Before creating a document collection, it is important to create the directory structure with 
the desired hierarchical levels first. 

Using Windows Explorer, plan the file structure in advance and create the directories you 
need for the different groups in your company. You can have sub-directories at the same 
level of a root directory as well as under other directories. Use Windows NT security 
options to share directories between groups. The directory structure needs to be viewable 
by the web server to build the document collection in KBMake. The following example 
contains a simple directory structure:

After creating the directory structure, move the documents you will use to create 
document collections into the appropriate directories. You can then have a SME (Subject 
Matter Expert) or another designated person control the content that is published to the 
Web for their group. 

In KBMake, you will determine what directory you want to contain the built document 
collection. You can determine where to save a document collection so that only people 
with access to a site on that directory will see its contents. For more information on 
working with the directory structure in KBMake, see “Creating a Document Collection” 
on page 4-12. 

Note: It is important to note that the designated directory structure is the authoritative 
version of the document. The .nfo is an indexed version of the document that is 
displayed to end-users and it is not a safe place to store information, which is why 
the SME or designated person should perform a build (in KBMake) after making 
any changes to the source documents. The authoritative version of .nfo documents 
are the original source files. The indexed .nfo version mirrors the authoritative 
version.

Fig. 4.2 Simple directory structure
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Creating a Document Collection
Use the KBMake utility to create a new document collection or update changes to an 
existing document collection. You will work with three types of files. They include:

• .bld — contains the settings for the .nfo 

• .mak — describes the internal hierarchy of the document collection

• .nfo — contains the document collection information users will view

To create a document collection:

1. Double-click KBMake.exe where you have Get.Answers! installed 
(\GetAnswers\builder\KBMake.exe). 

2. Name the document collection in the Document Collection File Name field. Browse 
for the directory you want to save the document collection to. The directory needs to 
be viewed from the server, not on a local hard drive.

3. Give the document collection a title in the Document Collection Title field. The title 
is what the user sees when they are performing an advanced search.

4. Name the make file in the MakeFile FileName field.  Usually the make file name is 
the same as the document collection name. Browse for the directory you want to save 
the make file to.

5. Browse for makefile.dtd in the DTD FileName field. This is the default .dtd file 
provided with Get.Answers!. We don’t recommend editing this file since it can cause 
unpredictable results.

6. In the Documents directory structure, select the directory that contains the files you 
want to use to create a document collection. Check the Traverse Subdirectories 
checkbox to include the files in the subdirectories below the root directory.
4-12 Creating a Document Collection



Note: For information on setting up the directory structure, see “Setting Up a Directory 
Structure” on page 4-11.

7. Specify the files you want to include and the files you want to exclude. For example, 
you may want to hide .gif files from an .html document that contains many graphic 
files. Separate the extension blocks with a semicolon. For example, “.doc; .htm; 
.html” is a sample of the files you may want to include.

8. If you are using .html files, you will see the IndexSheet field. Click the Browse 
button. By default, the HTML.xil file opens. It contains meta data information about 
the file. We don’t recommend editing this file since it can cause unpredictable results. 
If you are not using .html files to create a document collection, skip this step.

9. Click Save Build File to reuse your settings. This creates the .bld file.

10. Click Create Make File. This creates the .mak file.

11. Click Build Make File to create the document collection. This creates the .nfo file. A 
message opens indicating the document collection was created. A log file is also 
created. The log file is a text file that contains a list of errors and warnings. You can 
view the log file to check for and fix errors. 

Uncheck this box if 
you don’t want to 
include 
subdirectories 
below the root 
directory you 
selected.

Fig. 4.3 Directory structure in KBMake
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Adding a Knowledgebase or Document Collection to 
SiteAdmin

After creating a knowledgebase or document collection, use SiteAdmin to add (or remove) 
knowledgebases and document collections to a site. 

1. Double-click SiteAdmin.exe where you have Get.Answers! installed 
(\GetAnswers\bin\SiteAdmin.exe). 

2. Select the desired site definition file and click Open. The .sdf file you choose 
determines the site to which the knowledgebase or document collection is added. 
Once you add the knowledgebase or document collection to the site, the contents of 
the knowledgebase or document collection can be viewed by everyone with access to 
that site.

3. Click Add to locate the knowledgebase or document collection you want. 

4. Browse for the knowledgebase or document collection and click Open. This adds the 
knowledgebase or document collection to the specified site.

Refreshing the Get.Answers! Server
You need to refresh the Get.Answers! server after adding a new site. To do this, peform 
the following steps:

1. Open SiteAdmin.exe located in \GetAnswers\bin.

2. Select the GetAnswers.sdf  file.

3. Remove one of the .nfo files from the list. It does not matter which file you choose 
because you will add it back again.

4. Click the Add button to reselect the .nfo you previously removed.

5. Close SiteAdmin when you finish adding the .nfo file.

Note: This is a shortcut method to refresh the Get.Answers! server. You can do this 
instead of stopping the World Wide Web Publishing service when you add a new 
site.
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Setting Up an Automated Build
If you have new knowledgebases or document collections created on a regular basis, you 
can perform an automated build to include any new knowledgebases or document 
collections so users can access them in Get.Answers!.

To run an automated build, do the following:

• Make a copy of Template.bat located in \Program Files\GetAnswers\bin. After 
copying the file, modify the path and file names according to the instructions in the 
Template.bat file.

• Use the desired Automation utility (i.e. Windows ‘at’ command) or KBMakeCon.exe 
or SiteAdminCon.exe to perform a batch file update.

Note: Use quotes in the path name to ensure that any spaces or periods will not cause 
any errors.

The following Template.bat sample includes instructions for modifying the file:
REM Sample batch file for KBMakeCon and SiteAdminCon command line
runs.

REM

REM The console versions "KBMakeCon.exe" and "SiteAdminCon.exe"
invoke "KBMake" and "SiteAdmin".

REM The console versions will not return control to the batch file
until they are complete, allowing the programs to be chained
together in a batch file.

REM

REM You will need to change the path and file names to suit your
system configuration.

REM

REM You must run KBMake from Windows to create a build file before
using the command line.

REM The command line for KBMake, KBMakeCon, will create a new make
file based on your settings in the build file.

REM KBMakeCon will then build the NEW make file into the document
collection specified in the build file.

REM You may check the log file for errors after the program has
completed.

REM

REM Step One.

REM

REM Run SiteAdminCon.exe to take your NFO offline.

REM
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REM The parameters needed for SiteAdminCon command line are: the
full path and file name of the ".sdf" (Site Definition File) that
contains the ".nfo" knowledgebase/document collection you want to
take offline.

REM The second parameter is the full path and file name of the
".nfo" knowledgebase/document collection to be taken offline or put
online.

REM The third parameter is online or offline. By taking an ".nfo"
offline, it is no longer accessible by the GetAnswers server and
may be modified or replaced.

REM If your path or file names include spaces or other special
characters, you should enclose the parameter in quotes.

REM

REM C:\program files\getanswers\bin\siteadmincon Getanswers.sdf
Sample.nfo offline

REM

REM Step Two.

REM

REM Replace your knowledgebase or use KBMakeCon to rebuild your
document collection.

REM Once your document collection/knowledgebase is offline, you may
rebuild with KBMakeCon or replace a knowledgebase with a newer
version.

REM

REM The only parameter needed for KBMakeCon command line is the
full path and file name of the ".bld" file you wish to make. If
your path or file name includes spaces or other special characters,
you should enclose the parameter in quotes.

REM

C:\program files\getanswers\builder\KBMakeCon "c:\program
files\getanswers\builder\BuildFile.bld"

REM

REM

REM Step Three.

REM

REM Use SiteAdminCon to put your ".nfo" back online for searching.

REM

C:\program files\getanswers\bin\siteadmincon Getanswers.sdf Sam-
ple.nfo online

REM

REM

REM You can build and refresh multiple files by simply copying the
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above two lines over and over and adjusting them to the correct
files. See Below:

REM

REM <path>SiteAdminCon <Site Definition File> <nfo1> <offline>

REM <path>KBMakeCon <build file>

REM <path>SiteAdminCon <Site Definition File> <nfo1> <online>

REM <path>SiteAdminCon <Site Definition File> <nfo2> <offline>

REM <path>KBMakeCon <build file>

REM <path>SiteAdminCon <Site Definition File> <nfo2> <online>

REM

REM
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Ge
Chapter 5
NT Challenge and Response
NT Challenge and Response is one of the ways NT facilitates the authentication of users 
on a web server. The process consists of a secure handshake between the browser (IE) and 
the web server (IIS). The handshake lets the web server know exactly who the user is, 
based on how they logged on to their workstation. This allows the web server to restrict 
access to files or application based on who the user is. Applications running on the web 
server can use this information to identify the user without requiring them to log in.

Get.It! uses NT Challenge and Response as follows:

• The user logs on to an NT workstation.

• The user starts an IE browser and navigates to the Get.It! Login.asp page.

• IE automatically sends user authentication information to IIS. The user’s password is 
not transferred, but the NT Challenge and Response handshake between IE and IIS is 
enough for the server to recognize the user.

• The Get.It! login automatically detects the user by using the NT Challenge and 
Response/IIS server data.

• Get.It! logs in the user without requiring a name and password be entered.

During this process, Archway authenticates and impersonates the NT user with each of its 
adapters.

Thes following circumstances must be handled during this process:

• The NT user is not yet registered with an Archway Adapter. When this occurs, Get.It! 
asks the user to register and enter profile information. Get.It! then lets the user log in 
and stores this information for future login attempts. 

• The NT user name is already registered as an Administrator in AssetCenter or 
ServiceCenter. When this occurs, Get.It! does not proceed with automatic login. The 
user is presented with another login screen and is asked to verify their password. This 
step is an added security measure to prevent a user from accidentally logging in with 
administrative rights. 
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Setting Up NT Challenge 
and Response

1. Open the IIS Management Console.

2. Click on the getit virtual directory.

3. Right-click on login.asp and select Properties.

4. Select the File Security tab.

5. Click Edit in the “Anonymous Access and Authentication Control” section.

Fig. 5.1 Updating the login.asp 
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6. Check “Windows NT/Challenge and Response.” Make sure this is the only option 
checked. Click OK.

7. Click OK on the other windows until you return to the Microsoft Management 
Console (shown in figure 5.1).

Updating the loginverify.asp

1. Repeat the steps above for loginverify.asp. Follow the steps 3 through 5 as they 
are written above except select loginverify.asp instead of login.asp.

2. In the Authentication Method window, check the Allow Anonymous Access and 
Windows NT Challenge/Response options. Click OK.

Fig. 5.2 Setting Authentication for login.asp
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3. Click OK on the other windows until you return to the Microsoft Management 
Console (shown in figure 5.1).

Fig. 5.3 Setting Authentication for loginverify.asp
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Setting Permissions for the Presentation Folder

1. Use the Windows NT Explorer to navigate to the ...getit/presentation folder.

2. Right-click on presentation/ and select Properties.

3. Under the Security tab, click Permissions. 

Note: If you do not see a Security tab, verify that Get.IT! is installed on an NTFS 
partition.

Fig. 5.4 Locating the presentation folder
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4. Click Add to change the user groups that have permission to access the folder. 
Change the permission to a named authenticated group. For example, you could 
change permissions to all “Authenticated Users.”

5. If the user group called “Everyone” has permissions, highlight the entry then click 
Remove so that only the group you selected in the previous step can access Get.It!

6. Click OK. Close all remaining windows.

Testing the Settings

Log into Get.It! to make sure the access permissions are set correctly. The NT Challenge 
and Response settings are activated when you log into Get.It! through a special login page 
named login.asp. Accessing Get.It! through the standard login.htm page results in the 
users needing to login as usual. 

1. Open a web browser.

2. Enter the following URL: http://webserver/getit/login.asp in the browser 
address field (replace webserver with the name of your web server and getit with the 
virtual directory name).

3. Verify access to Get.It! is what you expected based on the settings you chose for the 
login.asp and loginverify.asp files. 

Fig. 5.5 Giving permission to authenticated users
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Setting the Default Login as login.asp

You can set the default login within Get.It! to use the NT Challenge and Response set-
tings. 

1. Open the login.htm file in the ...getit/presentation/ directory.

2. Locate the following:

function onPageLoad()
{

top.location.replace( "login.jsp" );
}
</script>

<body onLoad="return onPageLoad();">

3. Change login.jsp to login.asp.

4. Save your changes. 
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Chapter 6
Catalog Information
Get.Resources! makes use of AssetCenter’s product catalog contained within the amProd-
uct table. Except for two specific areas, the catalog should be configured as normal.

Certification
Get.Resources! uses the Certification field to distinguish between available of goods.

These buttons from the Get.Resources! menu each drive a database call against the 
amProduct table. The queries executed are similar to the following for Desktop Comput-
ers:

Fig. 6.1 Standard catalog options in Get.Resources!
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SELECT lProdId,Brand,Model,mPrice FROM amProduct WHERE
(Certification LIKE '%Desktop%')

With the exception of the Bundle certification, all may be easily changed to better reflect 
the client’s categorization scheme. 

The Bundle certification is special within the weblication. Bundles are groups of items tied 
together as a common good. For example, a “Sales Laptop” Bundle may consist of a lap-
top, PCMCIA NIC, Operating System software, and some applications. This relationship 
is built within the amProdCompo table, tying together several records from the amProduct 
table. There is code in place within the procure.js script to give special treatment to Bun-
dles.

Calculated Field: cf_Description

In order to provide meaningful information to users of the weblication, a calculated field is 
used as a descriptive name for records within the catalog. As identified in the Product 
schema, the field, Description, maps to the field cf_Description, a calculated field. The 
definition of that field follows. 

This is provided as a sample of how AssetCenter’s calculated fields may be used within 
the Weblication to ease data presentation.
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Netscape Navigator Support
If you are creating Certifications and are designing them for the Netscape Navigator 
browser then you must modify your weblication accordingly. When a Certification has a 
space in it then the weblication entry must include %20 instead of a space (delimited by 
quotation marks).

<link target-form=...param=”Certification=PC%20Desktop”...>
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Chapter 7
File Attachment
Overview
The underlying programs that Get.It! uses for its back end often have the capability to 
store file information in a database. This allows storing of data that does not need to be 
retyped or data that is in a visual format that will not fit into the typical data input options 
allowable. This data can provide extra information that would otherwise be unavailable.

HTML supports a field that allows the user to select a local file and upload the file to the 
server. By implementing this functionality, Get.It! provides support for gathering more 
data for server requests that internal personnel can then view through the back-end clients.

There are three parts to File Attachment usage within Get.It!: 

• Uploading a file to the Web server 

• Attaching the file to the appropriate back-end record 

• Displaying information about a file or the file itself within the Get.It! form

This chapter is divided into two sections:

• Administrator Procedures—includes File Attachment setup and security 
considerations, and information about the XML calls that provide the user 
functionality described in the User Procedures section.

• User Procedures—includes instructions for uploading a file and for displaying existing 
file attachment information in a Web browser.
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Administrator Procedures
The system default is to store attached files in the \presentation\attachments direc-
tory. However, this can open your system to possible security vulnerability. As a safe-
guard to your system, it is recommended that you create a virtual directory at the root level 
that references the attachment directory. You will also need to update the arch-
way.ini file to include information about the virtual directory.

Adding the Attachments Virtual Directory 

The procedure below uses Internet Information Services (IIS) as an example of creating a 
virtual directory. 

1. Create a directory at root level called attachments (c:\attachments).

2. Delete the getit\attachments folder.

3. Open IIS.

4. Right-click on your default Web site, and then choose New -> Virtual Directory.

5. Click Next.

The Virtual Directory Alias dialog box is displayed.

Fig. 7.1 Internet Information Services
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6. Type “attachments” in the Alias field. Click Next.

The Web Site Content Directory dialog box is displayed.

Fig. 7.2 Virtual Directory Alias

Fig. 7.3 Web Site Content Directory
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7. In the Directory field, type “c:\attachments”, and then click Next.

The Access Permissions dialog box is displayed.

8. Select “Read” and “Write” permissions only. Click Next.

A new virtual directory, attachments, is created.

Continue to the following procedure to update the archway.ini file.

Updating the archway.ini File

After you have added the virtual directory, you will need to update the 
archway.ini file as follows:

1. Shut down JRun before you edit the INI file.

2. Open the archway.ini file and add the following parameters:

• attachvirpath=/attachments/

• attachserverpath=c:\attachments\

3. Save the file, and then restart JRun.

The following sections include configuration information. Refer to User Procedures on 
page 4-9 for instructions on using the File Attachment function.

Fig. 7.4 Access Permissions
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Archway.ini Parameters

File Attachments uses defaults that can be overridden by the following parameters in the 
archway.ini file. These parameters allow you to set the paths for the file attachments 
and to establish a maximum allowable size for the attachment.

Attaching a File To a Record

After a file has been uploaded to the Web server, further processing is required to actually 
upload the file to the back-end server.

Security Considerations
Allowing the user to upload files to the Web server is accomplished by an XML line. The 
files are loaded into an attachments directory, separate from the presentation direc-
tory used by the other Get.It! pages. This allows you to choose whether to allow addition 
of attachments to a record automatically or to quarantine uploaded documents until they 
have been reviewed or scanned for viruses. 

A default HTML file is included in the \presentation\attachments directory to pre-
vent directory browsing, again for security reasons to prevent users from viewing 
unneeded information on the server.

For automatic inclusion of a file into a record, modifications to the Jscript are required and 
should be placed after the call for creating or updating a new record. Code for doing this is 
included in the service.js file in the
service/jscript directory and is contained in the function newTicket() and the 
function updateTicket(). The function to make this call to file attachments is located in 
the file common/jscripts/fileattachment.js.

Parameter Description

attachvirpath Sets the Web directory reference from which files will be 
drawn for viewing. The default is 
/getit/attachments/ if not set in the 
archway.ini file.

attachserverpath Sets the physical path on the Web server where the files 
will be stored. The default is <getit
home>\presentation\attachments\ if not set in the 
archway.ini file.

attachmaxsize Establishes the maximum size in KB for an attached file. 
The default is 2048 KB (2 MB).
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Uploading the Document to the Database
After a message has been built and then sent to Archway via the sendDocInsert, the func-
tion fileattachment.attachfiles is called. The calling sequence is:

fileattachment.attachfiles( adapter type, schema, recordid, files);

Below is sample code showing how to do the file upload for ServiceCenter.
function updateTicket( msg )
{

var msgTicket = new Message( "Problem" );
msgTicket.set( "Description", msg.get( "newupdate" ) );
msgTicket.set( "ID", msg.get( "Id" ) );

archway.sendDocUpdate( "sc", msgTicket );

fileattachment.attachFiles( "sc", msgTicket.getDocument ()
.getTagName(), msgTicket.get( "Id" ), msg.get( "FileName" ))

return msgTicket;

}

msgTicket.getDocument() .getTagName()—gets the value for the schema 
based on the XML document defined when creating msgTicket.

msgTicket.get( "Id" )—returns the identifier for which ticket should be updated in 
ServiceCenter.

msg.get( "FileName" )—gathers the list of file names stored in the form field 
specified in the XLM.

Parameter Description

adapter type Defines which back end systems the files should be uploaded to. 
ServiceCenter and AssetCenter are supported. For the adapter type, type 
“sc” for ServiceCenter or “ac” for AssetCenter.

schema name The name of the schema that is used to define the database table 
properties.

recordid The unique identifier for the record being uploaded.

files A list of the files that were uploaded.
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XML Calls

When a user uploads a file to the Web server or requests that information from a file be 
displayed in the Web browser, the process is accomplished through an XML call. The fol-
lowing section describes these calls. See “User Procedures” on page 7-9 for the user 
instructions for performing these tasks.

Uploading and Displaying a File
A weblication defines the upload and view file attachments functions as follows:

<input label=”labelname” type=”attachments” record=”record name”
adapter=”adapter type” field=”fieldname” add=”true/false”
remove=”true/false” view=”true/false” submitonly=”true/false”
id=”record id” colspan=”4”/>

Example:

<input label=”File Attachments” type=”attachments” record=”Problem”
adapter=”sc” field=”FileName” colspan=”4”/>

Attribute Description

label The title which will appear next to the select box. In this 
example, File Attachments will appear next to the 
select/combo box.

type The type of input field being set, in this case, the type is 
attachments.

record The table name in the back-end database which is to be 
updated.

adapter The adapter to be used to communicate with the back-end 
database

field The name for the HTML field that is updated in the screen. 
This does not have to correspond to a field in the database 
records, although it can.

add If this attribute is set to true, a user can upload files; if it is 
set to false, uploading is not allowed. The default is true.

remove If this attribute is set to true, the user can remove a file name 
from the select list. The default is false. Note: The file name 
is deleted from the selection list on the form only; it is not 
removed from the server.
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view If this attribute is set to true, the user can view an uploaded 
file through a browser window. The file will be viewed 
according to the default settings for that type of application 
within the browser. The default is true.

submitonly Not being used at this time. A placeholder for future 
implementation.

id The identifier for the record which is being updated with the 
file attachments in the back end.
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User Procedures

Uploading a File to the Web Server

You can use this function to attach a file to new or existing records in a back-end database. 

Files uploaded to the Web server are placed in an attachments directory, a separate 
directory from the presentation directory used by the other Get.It! pages. This direc-
tory defaults to presentation/attachments.

The following procedure uses a problem ticket in ServiceCenter as an example, but the 
procedures for attaching to forms using other databases would be similar.

1. With a problem ticket form displayed, click the add button (plus sign) in the “Add file 
attachments” section at the bottom of the form.

Add View

Fig. 7.5 File attachment 
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A dialog box is displayed in which you can enter the path to the file you want to 
attach.

2. Type the path to the file you want to attach. Or click Browse to select a file, and then 
click Open. 

3. Click OK in the Select a File dialog box. 

The file is added to the Attachments drop-down list.

Deleting an Attached File

Delete privileges must be added by the developer responsible for customizing the Get.It! 
system. If this function has been added, select the file name in the Attachments drop-down 
list. Click the delete button (minus sign). The file is removed from the list.

Fig. 7.6 Dialog box for choosing a file to attach
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Viewing an Attached File

Attached files can be viewed in a separate window that is accessed from the problem 
ticket. 
To display an attached file:

1. In the Attachments drop-down list, select the name of the file you want to view. 

2. Click the view button (magnifying glass).

The file is brought up in a separate browser window, according to the default settings 
for the browser. How the file is displayed will vary depending on your browser and 
how your individual machine is set up. 

In the following example, the .xls type of file is not set to be viewed automatically, 
so the user is given the choice to open the file or save it to disk. For files like .html, 
.jps, .gif, or other HTML-type files, the file will just open in the browser.

There must be an exist-
ing virtual directory with 
an alias of “attach-
ments” in order for you 
to be able to display 
attachments. Refer to 
Administrator Proce-
dures on page 4-2 for 
instructions.

Fig. 7.7 File Attachment drop-down list

View attachment

If the attachment is 
an executable (.exe) 
file, it is recom-
mended that you 
save it to disk rather 
than opening it. You 
can then scan the file 
for viruses before 
opening it.
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3. To view the file, select “Open this file from its current location,” and then click OK.

The file is displayed in a separate window in the browser.

Fig. 7.8 File download options

Fig. 7.9 Viewing an attached file
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Chapter 8
Troubleshooting
Use this chapter to determine which part of the process is not working correctly. The fol-
lowing sections explain validating connection with the web server, virtual directories, IIS 
configuration, Apache and JRun problems, and portal display. 

Installation

Q. What should I do if I receive errors during the Get.It! installation? 

A. Uninstall Get.It and uninstall JRun. Verify that both applications are deleted as well as 
any remaining directories (consult the scripts directory {default is C:\Inet-
pub\scripts} and delete or move all remaining files). Reboot your PC, stop IIS, and 
reinstall Get.It! and JRun.

IIS Configuration

Q. How do I verify the IIS Configuration?

A. Launch a web browser and connect with the web server by inserting the URL for the 
local webserver. Type one of the following three options for the URL: http://local-
host (local machine), http://127.0.0.1 (IP address for local host), or http://
machinename (replace machinename with the actual machine name).

Inserting any of these URLs should connect you with the default homepage for the web 
server. If you successfully connect then the web server is working correctly. If you are 
unable to connect with the default web page then the problem is with the web server. 

Make sure that you have a virtual directory for Get.It! on the web server. Display the IIS 
console and click on the web site where Get.It! is installed. Verify that a directory named 
getit exists. You may see more than one getit virtual directory. The format will be 
getit_vm(n) where (n) is a sequential number that you assign. If there is not a getit 
directory then you need to create one that points to ...getit\presentation, where 
Get.It! is installed. See Chapter 2, "Windows NT Installation Procedures," in the Installa-
tion Guide for instructions. If a getit directory exists, right-click it and select Properties. 
Verify that all Properties are selected, such as Write Access, Script Execute. Also verify 
that Access Permission are selected for both Read and Write capability.
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Using a browser, connect with the virtual directory (e.g., http://localhost/getit/
login.jsp).

If you can access the web server using the method in the first step, but cannot connect with 
the Get.It! directory in this step, there is a problem with the virtual directory configuration. 
Verify its creation and settings based upon the recommendations defined in Chapter 2, 
"Windows NT Installation Procedures," in the Get.It! Installation Guide.

If you see JSP code in the browser then JRun is incorrectly installed. The browser may 
display the subdirectory and all JSP files. This means that the initial IIS configuration is 
incorrect. Use the IIS console to locate the getit virtual directory, right-click on the 
directory name, and select Properties. Examine the default document setting in the “Docu-
ments” tab. Make sure that you have the following entries: Default.htm, Default.asp,  
Default.asp, and Login.jsp.

Internal Server Error Messages 

Q. What should I do if I receive an internal server error while running Get.It!?

A. There is an error in the JSP file that you are accessing.. You must delete all compiled 
objects and then recompile with JRun. First, use Windows NT Explorer to locate the 
...\jrun\jsm-default\services\jse\servlets\jsp\getit\ directory. Delete 
all files within this directory and then delete all JSP files from the ...\getit\presen-
tation\ directory. Display a Command Prompt (Start > Programs > Command Prompt). 
Change the directory to C:\Program Files\getit\bin. You should see C:\> as your 
prompt. Type cd program files\getit\bin and press ENTER. Type wbuild getit 
at the prompt and press ENTER (this command lists all processing it is going through). 
Log into Get.It. 

JRun 

Q. How do I very the JRun Connector Filter? 

A. Verify that the web server is correctly configured for all ISAPI filters. The most impor-
tant filter is the JRun Connector Filter. To verify this filter, open the IIS Console, right-
click on the web server icon within the console, and select Properties. Click Edit and then 
click ISAPI Filters. Verify that the Status column has a green arrow pointing up for all fil-
ters, the most important being the JRun filter. If you see the error “Could not connect to 
the JRun Connector proxy” when accessing login.jsp, start the JRun server. You can 
either do this from Control Panel > Services or from Start > Programs > JRun menu.

Q. Do I have to restart JRun each time that I create a modification in Get.It! ?

A. In a development environment you will want the setting debugscript set to true. 
Each time that you create a modification to JScript the change will automatically occur 
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when the script is executed. Without this setting turned on you will have to restart JRun 
each time a modification is made to the JScript. Do not leave this setting turned on (set to 
true) in a production environment, due to overhead.

Apache/JRun 

Q. Get.It! is installed on an Apache web server with JRun., but the Get.It! screens do not 
display. How do I correct this?

A. JRun may be running incorrectly. If the text of the JSP files can be displayed, either 
JRun is not running or Apache is not loading the JRun module correctly. Consult the 
README.apache file located within the JRun directory for instructions on setting up JRun 
to work with Apache. This may involve installing a 1.3.4 version or greater release of 
Apache and then recompiling the Apache web server on your platform. Test the JRun 
installation by making use of the sample JSP files in the JRun directory or by using the 
sample JSP file located in the ...\jrun\contrib\jspc\hello.jsp directory. Copy a 
file to the Apache directory and then display it in a browser. If “Hello World” displays in 
the browser then JRun is working. If the text of the file displays then JRun is not working 
and the README.apache document should be reviewed. 

It may also be that Apache is configured incorrectly. If Apache is incorrectly configured 
then the message “Internal Server Error” or “Directory or file not found” appears. Add the 
following lines to httpd.conf to configure the presentation directory:
Alias /getit/ “/usr/local/getit/presentation/”
<Directory “/usr/local/getit”>
Options Indexes MultiViews
AllowOverride None
Options ExecCGI
Order allow,deny
Allow from all

</Directory>

Using a ScriptAlias directive does not solve the problem and generates the “Internal 
Server Error” when JSP pages are called. If no Alias is established then the “Directory or 
file not found” error is displayed in the browser. The Directory directive section speci-
fies that those files within the presentation directory should be allowed to execute and 
that other files, such as graphics, are viewable and therefore not executable. Without this 
option JSP files will not execute when called.

Verify that the JRun installer added JRun settings to the end of Apache’s httpd.conf. If 
not, reinstall JRun. Finally, verify that JRun’s LoadModule live in httpd.conf is not com-
mented out with a hash (#).
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Get.It!

Q. Where should my Get.It! user modifications go?

A. Application or form user modifications should reside in the 
...getit\apps\user\weblication directory. Jscript user modifications reside in the 
...getit\apps\user\jscript directory. Schema user modifications reside in the 
...getit\apps\user\schema directory. 

Q. Can I remove password authentication in Get.It!?

A. Yes. The JavaScript that authenticates user login is located in the ...\apps\com-
mon\jscript\login.js file. Located within this file you will find the login() func-
tion. Overriding this function will remove password authentication. 

Q. Can I access any screen within Get.It! from any page on the web?

A. Yes. When wbuild is run each JSP page that is created in the ...getit\presenta-
tion directory contains code to check if the user is already logged in or requires a login to 
Get.It! This means that you can move to any form in Get.it! and authentication will be per-
formed. To access a Get.It! screen from an HTML page, find the JSP page you want to 
link to. It will reside in the ...getit\presentation directory. Then use the <a> tag to 
link to the page. For example:
<html>
<ahref=”http://localhost/getit/
e_service_report_describe.jsp?Category=software&Priority=high">Ope
n a Problem</a>
</html>

Q. What debugging facilities are available in Get.It!?

A. Login as an administrator in Get.It! and modify the Administration Module Settings. 
Ensure that logfile and sclog are set to a valid location and make sure that debuglog 
and debugscript are set to true. These settings are stored within ...getit\bin\arch-
way.ini. Any call via archway will then be logged. You can also write to the logs from 
JScript using the env.debuglog statement as shown below.

env.debuglog("### Here are the contents of msgResult " +
msgResult.getContent() );

Do not leave debuglog and debugscript set to true once you are in a production 
environment unless absolutely necessary for debugging purposes.

Q. Sections of different forms in my Get.It! application are identical. Is this code redun-
dant?

A. The <component> tag will help you to create a common section of XML. The follow-
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ing is an example of a <component> called detail.

<components>
<component name="detail">

<fieldtable>
<row>

<field label="Status" field="Status"/>
<field label="Ticket number" field="Id"/>
</row>

....
<fields>
<input type="hidden" field="Id" value="$$(Id)"/>
<input type="hidden" field="Status" value="$$(Status)"/>

</fields>
</component>

</components>

Now you can reference the common section of xml code using the components tag within 
a form as follows:
<form.......>
........
<component name="detail"/>
.......
</form>

Q. What is the form stats display?

A. The form stats display is a useful method of determining the location of a form within 
an activity and module in the apps directory. To turn on the form stats display, you must 
login to Get.It! as an Administrator and then modify the Setting displayforminfo to 
true. This will create a window in the left sidebar when accessing Get.It! screens. The 
window will display the current module, activity, and form.

Q. How can I modify the size of a font on the Get.It! screens?

A. You must modify the ...getit\presentation\css\blues.css file. If you are 
using Netscape Navigator as your browser then modify the file in ...getit\presenta-
tion\ns_css\blues.css.

Q. How can I modify the labels for the Home and Back buttons?

A. You can control this by overriding when Home is generated in the XSL files. Locate 
the following in forms.xsl:
<!-- Create Home button -->
<xsl:template match="actions/home">
<script language="JavaScript">
function onHome( form )
{
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location.href = "appmenu.jsp";
}
</script>
<input
class="ActionButton"
type="button"
name="{@name}"
value="Home"
onclick="onHome();"/>
</xsl:template>

You can copy this to user.xsl and change the bold text to whatever you want. The Back 
button is defined prior to the Home button.

Portal

Q. When I run Get.It! using ServiceCenter I don’t see the portal. How do I get the portal?

A. After installing Get.It,! restart both Archway and ServiceCenter. If you have not 
restarted both of these applications then this may explain the absence of the portal. If you 
install or update a version of Get.It! there are several possibilities that may explain this 
inability to view the portal. One possibility is that the portal.inl file may be missing, if 
you are using the SC Adapter as your Portal backend. 

To fix this, import this file by clicking Start > Programs > ServiceCenter and open the Ser-
viceCenter console. Then click Start. Next, click Start > Programs > ServiceCenter > Ser-
viceCenter Client. Log in as an Administrator. Click the Toolkit tab and then Database 
Manager. Click on Options > Import/Load. Insert .../getit/config/Service-
Center/portal.unl in File Name and then click Load fg. 

Also verify that your user has the getit.portal access right, either in the default access right 
list in Get.It!’s Admin Settings or in the user’s ServiceCenter or AssetCenter profile.

Scripting

Q. How can I embed HTML code that contains JavaScript in a Get.It! XML form tag?

A. If your embedded HTML code contains JavaScript, you may want to use JScript to 
build both the JavaScript and HTML. You must first create your HTML tags in the webli-
cation form and then reference a variable. For instance,
<form name="start" onload="service.buildhtm">
.....
<html>
$$(Stuff)
</html>
.....
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Now you build the Stuff variable in the JScript that is referenced in the onload parameter 
of the form. In this case service.buildhtm.

var Stuff="<!-- JavaScript code and Level 1 menu -->";
Stuff+="<script language='JavaScript'>";
Stuff+="function findObj(n, d) {";
.....
Stuff+="</script>";
Stuff+="<table align='left' CELLSPACING='3' CELLPADDING='3'
WIDTH='200'>";
....
msg.add ( "Stuff", Stuff );
return msg;

You may want to add a debug statement to see what your HTML code looks like:
env.debuglog("#### This is the html code " + Stuff );

Q. Can I call external servlets from Get.It!?

A. Yes. The following is an example of JScript that calls an external servlet and then 
passes that servlet a field called “Id” as a parameter. The servlet returns a message in an 
XML document format.
msgReturn = archway.sendHTTP( "http://something.something.com:1888/
servlet/servlets.GetitTest?testparam="+id, null );

Q. Can I call an HTTP page from Get.It!?

A. Yes. This example shows how to add a button to a form that links to an HTML page 
that provides Help.
<actions target-form="example">
<submit> Refresh List </submit>
<home> Home </home>
<link target-url="http://someplace.around.com/help101.html"
window="true"> Help </link>
</actions>

Q. How are client-side JavaScript and Java Applets viewed in unsupporting browsers?

A. Because Get.It! utilizes client-side JavaScript, numerous screens will not work prop-
erly in an unsupported browser. Get.It! uses one Java applet that displays workflow and 
one for Portal Help. If you are using an unsupported browser then you will not see these 
applets.

Performance

Q: How are the database connections pooled? Is there performance limitation for an 
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11,000 user base?

A: When you install Get.It! you can configure your system to run on various, simulta-
neous Java Virtual Machines. Each machine runs parallel but separate processes and 
maintains its own database connection. This may be useful when running on multiproces-
sor machines.

Q: Does Get.It! interface with NT Authentication for application sign on?

A: We fully support NT Authentication based on the NT Challenge and Response mecha-
nism.

Q. How can I troubleshoot performance issues with Get.It!?

A. To troubleshoot system performance issues complete the following steps: 

1. Determine if there are any queries continually running that are trying to access many 
records. For example, you should check in the logs to see if there are queries with no 
where clauses. This can cause the system to loop which will use memory and cause 
unpredictable behavior.

2. Check the Administration Module Settings to ensure the “DebugScript” field is equal 
to false.  

3. Determine the number of ScriptRunners being created. The logs will indicate each 
time a ScriptRunner is created. Look for the lines that say:  “Added ScriptRunner to 
Pool” and count the number of times you see this. Check the maximum number of 
ScriptRunners allowed in the Administration Module Settings “MaxScriptRunners” 
field. It should be set to no higher than 10. 

4. Ensure any screens you have designed have clean onload scripts that do not pull in 
too much data. Remove combo boxes that display many options, converting them to 
searchable, popup fields. 

Browser

Q. Does Get.It work on a Netscape server and Netscape browser?

A. Yes. If you are installing on a Solaris machine, make sure you have the Get.It! CD cre-
ated specifically for Solaris. 

Q. How can I access cookies from Get.It!?

A. The following is the syntax for accessing cookies:
id = user.getCookie(“CookieName”);
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Get.Service!

Q. Can I perform functions in Get.Service! other than opening and updating a problem 
ticket?

A. You can perform any function in Get.Service! that can be processed by event services. 
Here is an example of sending a problem close event to event services and receiving a syn-
chronous.
var msgTicket = new Message( "epmc" );
msgTicket.set( "number", msg.get( "Id" ) );
msgTicket.set ( "LName", user.get("LastName") );
msgTicket.set ( "FName", user.get("FirstName") );
msgTicket.set( "resolution", msg.get( "newupdate" ) );
msgTicket = archway.sendEvent( "sc", msgTicket );
user.addMessage( "Ticket Number " + msg.get( "Id" ) + " has been
closed" );

wbuild

Q. When should I be using wbuild?

A. You need to run wbuild each time that you modify XML pages. For instance, you must 
run wbuild when you change a form in the ...getit\apps directory or when you mod-
ify a schema in the ...getit\apps\module\schema (where module is the name of the 
module, such as assets). wbuild rebuilds JSP pages in the ...getit\presentation
directory.

ServiceCenter 

Q. What do I do if I log into Get.It! with a valid SC User ID but do not see the Services or 
Answers options?

A. There is a ServiceCenter connectivity problem. Log into Get.It! as an Administrator. 
Access the Administration Module  (the Control Panel window is displayed). Check the 
Connection Status column for the Status of each Target/Adapter connection. If any Adapt-
ers are “disconnected,” verify the connection settingson the Settings page. If they are cor-
rect, restart the JRun service. 

If this does not change the status to “connected” then click Settings (this accesses the 
archway.ini file) and verify that the Adapters field contains the following 
sc=SCAdapter. If you are using AssetCenter then you will see adapters for both 
sc=SCAdapter and ac=ACAdapter.

Within the ServiceCenter Adapter Settings, verify that Host and Port are correct (Port 
refers to the full client port connection, “12670” by default). You may be using a different 
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Port. You can find your Port by looking at the sc.ini file on the ServiceCenter server 
and checking the “system:” parameter within this file. 

If you are using a Windows NT Server, proceed to the ServiceCenter server and access the 
ServiceCenter program directory (Start > Programs > ServiceCenter > Init File). If you are 
using a UNIX server, examine the sc.ini file in the JRun directory where ServiceCenter 
is installed. 

The sc.ini file should look something like the following:
#
# Installed Configuration
#
path:C:\Program Files\ServiceCenter\DATA
shared_memory:24000000
log:C:\Program Files\ServiceCenter\sc.log
bitmap_path:C:\Program Files\ServiceCenter\BITMAPS
system:12670
auth:A3D8724B 34330ABD 733C5EC2 8CB0DF6F
scauto:12690
ntservice:ServiceCenter

The value next to the “system:” parameter is the full client Port number. The Host name 
should be the name of the ServiceCenter machine name (name or IP address). Verify that 
the epmx.unl from ...getit\config\ServiceCenter is loaded into ServiceCenter 
via the Database Manager. 

First transfer the empx.unl file to the ServiceCenter server and start a full client. Log in 
as an Administrator, click on the Toolkit tab and then click Database Manager. Select 
Options and then Import/Load, Enter the full path to the epmx.unl file in the File Name 
field (e.g., C:\temp\epmx.unl), and click Load fg. Verify that the person who is trying 
to log in has the necessary “Execute Capability” words defined on their Operator Record. 
There are two possible entries. The first is getit.service(for access to creating updating and 
reviewing problem tickets through Get.It!). The second is getit.answers(for access to a  
knowledge base from Get.It!). These capability words are made available in Service-
Center when you load the epmx.unl file. 

They are added to the capability table but you must still add them to each operator record 
that you want to have access to. To add the capability words to an operator record log into 
ServiceCenter as an Administrator, select Problem Management and then Security Files. 
Click Edit in the “Users” section and select the user that you want to edit from the drop-
down list. Click OK and select Edit Operator Record (you should now see the operator 
record for the user you selected). Click the Startup tab in the operator record. Add the 
Get.It! capability words (getit.answers and/or getit.service) to the “Execute Capabilities” 
fields. Scroll down to the first available slot and click Update.

Q. What should I do if ServiceCenter is mapped to a SQL back end and it stops working?

A. Assuming that you have made no other modifications, the most probable scenario is 
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that the number of records in eventout is greater than the sqlfetch parameter in the 
sc.ini file. Ensure that the eventout table is properly keyed. This means that you must 
have a key on the evusrseq field. 

AssetCenter

Q. What should I do if I do not see the Resources and Status options?

A. There is an AssetCenter connectivity problem. Log into Get.It! as an Administrator and 
access the Get.It! Admin module. The Control Panel window is displayed. Check the con-
nection status of Get.It to AssetCenter to see if it says “connected” or “disconnected.”

If the status is “disconnected” reset the server by clicking Reset Server. If this does not 
change the status to “connected” then continue with the following. 

Click Settings  (this accesses the archway.ini file). Scroll down to see the AssetCenter 
Adapter Settings. Verify the “Database” field is pointing to the correct database, by 
default this field is set to ACDemo300ENG. Also make sure the Administrator and Anon-
ymous password fields have not been edited in the Admin module since these fields are 
encrypted. 

Log into the AssetCenter database on the AssetCenter server. Make sure the login account 
referenced in the Get.It! settings matches the login for AssetCenter. Check the ODBC 
connection. Depending on the way you run JRun it will look for a User DSN or a System 
DSN. If you start JRun as an application it will reference the User DSN for the ODBC 
connection to the database. If you start JRun as a service, it will reference the System DSN 
for the ODBC connection. While logged into AssetCenter, use the File menu to access the 
Manage Connections option. Verify that the user name and password are correct for the 
connection.

Q. Get.It! does not appear to recognize AssetCenter default script functionality. How do I 
correct this?

A. Make sure you have the appropriate user rights in the AssetCenter profile. If you 
change default scripts in AssetCenter make sure that you save your changes by discon-
necting from the database or through the tools\administration .../save the

database configuration menu entry. Restart JRun and then reconnect.

Q. When I call Get.It! from a client or a web server I receive an Unable To Find Page 
error. There is an error in the log that states Cannot Find amdb.ini. Is this problem cor-
rectable?

A. Yes. AssetCenter client must be installed with a valid connection established with the 
database, residing on the same machine as Get.It!
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Q. I have Get.It! connected with Oracle, but why doesn’t seem to be talking with the data-
base?

A. Add the following line to the SQL section of the aamapi30.ini file, located within 
the WINNT directory:
OracleDLL=oraclient8.dll

Error Codes

Q. Why do I receive the “XSL warning: Could not find macro def named: outpu-
tUserFields” error message?

A. You will receive this message if a weblication <input> element either lacks a type 
attribute or has an unsupported type value. 

For example, if the following line is in an XML file, it will generate the error because it 
lacks a type attribute:
<input label="Number to order" field="nCount" />

To correct the above line, enter the following instead:
<input label="Number to order" type="text" field="nCount" />

Firewalls

Q. Can users outside of the company firewall access Get.It!?

A. Get.It! has no firewall issues. If the user can access internal servers, they can access 
Get.It!. 
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